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Introduction

QUES$TOR has been designed to produce high level estimates of the
capital and operating costs of green field oil and gas developments. It
will assist with project modelling, evaluation and subsequent decision
making in the oil and gas industry.

QUES$TOR provides a reliable, consistent methodology for producing
cost estimates and creates efficiency when optimizing field
developments. It has benefits in many applications, including:

» Prospect evaluations
Screening studies
Feasibility studies
Conceptual studies
Optimization studies

QUES$TOR uses a systematic approach to generate a field development
basis, capital and operating costs, and project schedules from basic
field data. QUE$TOR uses a bottom up methodology; the calculations
are based around detailed sizing algorithms and engineering “rules of
thumb” with regional variations where appropriate.

This approach allows engineers, estimators and economists to produce
weight and cost estimates quickly, consistently, and accurately and to
develop investment profiles.

This guide is designed to help you understand the operation of the
QUES$TOR program, outlining the basic steps involved in developing a
QUES$TOR project to produce a scheduled estimate for capital and
operating costs. When you are running QUE$TOR, press the F1 key to
access the QUE$TOR Help file for more detailed guidance.
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Estimate Basis

The

following points should be considered when generating or

reporting a cost estimate using QUE$TOR.

QUES$TOR provides an estimate based on the costs within the
markets today. We make no allowance for inflation or deflation of
costs over the project life

All of the costs within QUE$TOR are in real terms

Pre-sanction project costs such as environmental studies, FEED
and licensing costs can be optionally included

Post-sanction costs such as owner’s project management costs,
legal costs and security costs can be optionally included
Contingencies within QUE$TOR are calibrated to target the P50
development cost

QUES$TOR is designed for use early in the project cycle. Therefore
the estimate level that can be attained by using the program is
typically within the range of +/- 25% to 40%

The estimate produced is dependent on user entered values.
Therefore, any estimate should take into account the confidence
of these values.
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About the Quick Start Guide

This guide is designed to help you understand the operation of the
QUE$TOR program, outlining the basic steps involved in developing a
QUES$TOR project to produce a scheduled estimate for capital and

operating costs.

QUES$TOR is structured around a field development schematic (FDS)
which allows you to create a visualization of the development. The FDS
is driven by a number of high level inputs which allow the development
conditions to be specified. The basic program calculation sequence
followed in QUE$TOR to generate a full life-cycle field or prospect
development cost estimate is shown below.

Create Project
Cffshore / Onshore

!

i Project Properties
Select location, product
and databases

¥
Field Level Data

Define reservair and field

characteristics
e "

!

Production Profile |

Define profiles, capacities
and number of wells

¥

Concept Selector
Select development
concept

¥

Field Development
Schematic
Adjust concept

r
Component Details
Madify and confirm
component design

-

LY

.

b, -
L1
OPEX
Calculate field OPEX
L.
- * ™

CAPEX Scheduling
Schedule CAPEX and
production start

¥

Investment and
Production Profile

Generate report
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To define the new project, QUE$TOR presents you with a series of
forms that allow high level parameters of the development to be
specified. The Field level data form is populated with default values for
the basin selected in the Project properties form. Subsequent forms
have values and selections based on earlier entries. Once you have
reviewed and adjusted as necessary the default inputs in each form,
click on OK to apply the inputs and move on to the next form. Click on
Cancel to ignore changes made and go back to the previous form and
make any necessary revisions.
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Getting Started

QUES$TOR must be installed on a local PC. This must be done by a local
administrator. See the release notes for installation instructions.

QUES$TOR will run on these following operating systems:

e Windows 10 [v1607]
e Windows 11

A license must be available to run QUE$TOR. The license can be either
a machine specific standalone license or a network license which is
accessible across your company's local area network. License codes are
emailed to users by S&P Global Customer Care, called Entitlement Ids,
the required licenses can then be activated or deactivated via an
internet connection.

QUE$TOR Offshore, QUE$TOR Onshore and QUE$TOR LNG
Regasification require separate licenses. Contact your IT department
for further details.

Depending on your installation options, you can launch QUE$TOR
either from the taskbar Start button or from your PC desktop.

e Windows 10

To run the software click the Start menu and browse the program
list to find S&P Global > QUE$TOR 2026 Q1 or double-click the
QUES$TOR 2026 Q1 icon created on your desktop.

e Windows 11

e To run the software click the Start menu and follow All Apps >
S&P Global > QUE$TOR 2026 Q1 > QUES$TOR 2026 Q1 or
double-click the QUE$TOR 2026 Q1 icon created on your
desktop.
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Creating a New Project
On opening QUE$TOR the task selection form will appear.

Create a new project
() New offshore project

() New onshore project

Open existing project
(®) Browse for project ...
() 1.CA_\SPGlobalQUESTOR Projects\Example 1
() 2 CA\_ \SPGlobal\QUESTOR \Projects\Example 2
() 3CA\ \SPGlobal\QUESTOR Projects\Example 2

Flease take a moment to provide us with yvour details
=0 that we can notify you of product releases,
updates, user group mestings and more.

Sign up now

On this form you can choose to create a new project, open an existing
project, and register the QUE$TOR software online via the Sign up
now option. The sign up now option also contains the ability to set
contact preferences and register for future product notification alerts.

For new projects you can either create a new offshore project or a new
onshore project. There are also shortcuts to the last five projects.

The location of your wells should determine whether you pick offshore
or onshore as the starting point. If you are running a combined
offshore and onshore project, then you can select the second location
later in the project estimate.

Once you have selected your project location (i.e. offshore or onshore),
select OK to open the Project properties form. QUE$TOR then
confirms that you have a valid license to run the selected project type.
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Selecting the Project Properties

The project properties allow you to setup the basic information about
your project including the procurement strategy, regional technical
database and units set preference.

MName |New offshore project

Units of measure

(®) Use built4n unit set Cilfield v
() Use custom unit set <Mone: Browse...
Main product
(® 0 () Gas
Location
Region Worldwide v
Country / territory Worldwide Average -
Basin/ play Waordwide Average ~

Procurement strategy

Calzers"Public'MyDocuments S PGlobal A UESTO R Procurement Strategies Browse...
MName Last modified by Last modified Yersion New
Wordwide Average Jonathan Ste...  8/9/202183%9 .. 213 View

Delete

Technical database

CUsersiPublic'MyDocuments 5 PGlobal 2 UESTORTechnical Databases Browse. ..

Name Type Last modified Wersion ~ Delete

M. Morth Sea (LK) Template 10/26/202254.. 223

Metherdands Template 10/26/20229.4... 223

Russia (Arctic) Template 10/26/2022 5.4 223

5. E. Asia Template 10/26/202254.. 223

5. Morth Sea (Morway) Template 10262022 54... 223 W

[] Proceed dirsctly to field schematic Cancel

Work through the following steps to set up your project:

Page 10 May 2026 S&P Global



QUE$TOR 2026 Q1 Quick Start Guide

e Give your project a name.

» Select the units you want to work in. Pick from one of the standard
unit sets provided or create your own using the Unit editor tool.
For the majority of users one of the default unit sets should meet
your needs as you can change each unit as needed throughout the
program.

Units of measure

(®) Use built4n unit set Qiffield

(O Use custom unit set

» Select the main product. For Oil projects you will have to define
your recoverable oil reserves and a gas oil ratio, while for gas
projects you will input your recoverable gas reserves and a
condensate gas ratio.

Main product

@il (O Gas

» Select the geographical region, country / territory, and basin to
enable QUE$TOR to seed your project with typical basin specific
data generated from the S&P Global E&P database. This selection
will also drive the default location of a hew procurement strategy
and will set your regional technical database.

Location
Region Worldwide
Country / territory Worldwide Average

Basin/ play Worldwide Average

« Create your procurement strategy. This can be done by clicking
the New button. This will display the Define procurement strategy
form shown below. Procurement strategies allow you to choose
different regional cost databases for each cost centre. By default
all costs are reported in US Dollars but this can be edited by
changing the currency name, symbol and exchange rate at the top
of the form.
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Define procurement strategy - Worldwide Average
Mew procuremert strategy cumency
Name  |US Dollars Symbol Exchange rate (per USS)
Offshare
Exchange
rate
Cost database Curmency (per 1JS8)
Contingency Guff of Mexico v | |US Dolar I 1
Equipment Gulf of Mexico e |L|S Dallar | | 'I|
Materials Gulf of Mexico + | |US Dollar R
Fabrication Gulf of Mexico e |L|S Dollar | | 'I|
Linepipe S.E. Asia ~ | |US Dollar [ 1]
Installation Guff of Mexico + | |US Dolar I
Design and Project management | Gulf of Mexico o |L|S Dollar | | 'I|
OPEX Gulf of Mexico v | |US Dolar [
Certification Gulf of Mexico W |L|S Daollar | | 'I|
Freight Gulf of Mexico + | |US Dollar [
Cancel

» Select the technical database to use for your project. By default
this will be the region which you have selected for your project. All
template databases are shown together with all custom databases
present in the path specified. Click Browse to select an
alternative path for custom databases if required.

Once you have completed the above steps, click OK to move onto the
Field level data form.
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Entering Your Field Level Data

The Field level data form contains three tabs which list the values for
the field characteristics, fluid characteristics and some miscellaneous
data respectively.

Field level data (offshaore)
Field characteristics ~ Fluid / profile characteristics  Miscellaneous

Field data
Recoverable reserves MMbkbl
Gas oil ratio scf /bbl
Reservoir depth from LAT s
Reservoir pressure 261| bara
Reservair temperature T
Reservoir length 712 km
Reservoir width km
Water depth 171 m

Q,{ Cancel

The information entered varies slightly depending on whether you have
selected an offshore or onshore project. Default values are populated
from a database relevant to the basin you selected in the Project
properties form.

On this form, modify the data to the specifics of the field that you want
to produce an estimate for. The purpose of the default data is to
provide a reasonable value where none is known and therefore you
should use your values over these defaults. Any input value can be
changed by simply over-typing it.

In this form, and any other form, the individual input units can be
changed ‘on the fly’ by clicking on the unit to the right of the value and
selecting the unit you wish to use from the options available, this is
shown for the recoverable reserves input below.
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Field level data (offshore)

Field characteristics  Fuid / profile charactenistics  Miscellaneous

Field data
Recoverable reserves 53| panani

Mm?® (thousand cubic metre)
Gas oil ratio 138

=0 MMm® (million cubic metre)
Mcf (thousand cubic foot)
MBCE (million cubic foot)

Reservoir depth from LAT

3

[}
=] (o] 3]
o o o
i - =1 =1

Reservoir pressure b - .

1 Bef (billion cubic foot)
Reservoir temperature i Tef (trillion cubic foot)
Reservair length 712l Mbbl (thousand barrel)

MMbbl (million barrel)
Reservoir width 156 | km [
‘Water depth 171 m
Z Cance

Once you have entered / confirmed the data on all three tabs click OK
to move onto the Production profile edit form.
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Creating a Production Profile

The production profile is created through two forms; the first form
gives seven entries through which you can influence the basic
parameters of your production profile.

Production profile edit

Onstream days

Concurrent driling operations

£
£n
=h (=]
(=9
[51]
=

Wells per year per operation 17

Flateau rate {daily equivalent) Mbbl/day
Years to plateau year
Flateau duration Ijl year

Field life year

e Cancel

Enter any of the values you know at this point and then click OK to
move onto the Production profile form which gives you a visual
representation of these values.

The production profile is displayed in a graphical and tabular format
across four tabs; oil (or condensate), gas, water and gross liquids.
Numbers in blue can be edited; numbers in black such as those in the
gross liquids tab are derived numbers and therefore can’t be edited.
This colour convention applies throughout QUE$TOR.
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Production profile
& (& =
il Gas Water Gross liquids
Daily Production {Hydrocarbon Liquids) Mew offshore project
100
80
& 60
=
o
0
= 40
20
0
1 2 3 4 5 G 7 & 9 10 1
Years
Production Units 1 2 3 4 ] 6 7 8
Dhaily Mbbl/day 48,000 56.000 96.000 56.000 56.000 84.508 65.116 50.175
Annual MMbblAT 16.200 33.600 33.600 33.600 33.600 29578 22791 17.561
Cumulative MMbEI 16.800 50.400 84.000 M7600 151200 180778 203563 221130
< >
@ Field data Madify profile Graph | Daily Production e Cancel

You can change the production for each year by entering the values in
the table at the bottom of the form. This can either be typed in year by
year or you can paste in a profile from an external spreadsheet through
a right mouse click. You can overwrite either the daily or annual
flowrates but not the cumulative row of the table. You can also copy the
data in the production profile and paste it into an external spreadsheet.

y
% Note: When pasting in a production profile from a spreadsheet
ensure that the field life specified in the production profile edit form is
the same as that of the profile you are pasting in.

Once you are happy with the production profile, click OK to move onto
the Design flowrates form.

Page 16 May 2026 S&P Global



QUE$TOR 2026 Q1 Quick Start Guide

Setting the Design Flowrates

The Design flowrates form gives the flowrates that will be used to
design the facilities within your project.

Design flowrates

Peak daily average production rates

Peak daily average Mbbl/day
Design rates

Design factor

Qil production flowrate Mbbl./day
Associated gas flowrate MMscf /day
Design water / oil percentage 11| %

Gross liquids flowrate Mbbl/day
Water injection

Water injection capacity factor

Water injection flow (1.1 = gross liquids rate) Mbbl/day
Gas injection

Gas injection flowrate MMscf /day
& Cancel

The production values are based on the peak production with a design
factor for oil projects giving an allowance for day to day variation, and a
swing factor in gas projects giving an allowance for seasonal demand
variation.

The injection values should be adjusted based on your pressure
maintenance and gas disposal assumptions. Water injection is
assumed by default for all oil projects.

Once you are happy with the design flowrates, click OK to move onto
the Number of wells form.
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Setting the Number of Wells

The Number of wells form, shown below, sets the total number of wells
required across the field.

Mumber of development wells

Development wells
Production
Water injection

Gas injection

Taotal

Pd p—
L £n | |

Production well count is the higher of the
two numbers from:

(3) & well productivity of 16 MMbblfwell
(b) A peak well flow of & Mbbl/day

& Canes

The default number of production wells is based on the recoverable
reserves, well productivity, plateau production and peak well flow. The
default number of water injection wells assumes an average of two
injectors for every five oil production wells. Gas injectors are based on
an average flowrate of 30 MMscf/day per well.

Modify the well count to match your design assumptions and click OK
to move onto the Wellhead conditions form for onshore projects or the
Concept selector form for offshore projects.
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Setting the Wellhead Conditions

The Wellhead conditions form is only available for onshore projects and
provides the wellhead conditions of the primary streams.

Wellhead conditions

Design wellhead pressure barg

Flowing wellhead pressure 113 | barg
Flawing wellhead temperature BE.9| T
Water injection pressure 112| barg
(Gas injection pressure barg

(Gas lift pressure barg

< Cancel

Water injection, gas injection and gas lift pressure are only relevant if
these services are selected. Adjust the conditions as necessary and
then click OK to move onto the Concept selector form.

S&P Global May 2026 Page 19



QUE$TOR 2026 Q1 Quick Start Guide

Selecting a Concept - Offshore

The Concept selector form allows you to choose the basic concept of
your field development.

Concept selector

Mew

Development concept
Production platform + Wellhead(s) w

Fixed steel jacket(s) supporting production manifolds tied back wia multiphase pipeline(s) to central production facilties
with oil/gas processing and living guarters on a fixed steel jacket in the field.

il export

Method pipeline to shore w
Distance to delivery point o

Gas disposal

Method inject into reservoir w

Distance to deliveny point Ijl [

& Carcsl

QUES$TOR selects a field development concept based on the field level
data and production profile. You can change this to another of the 14
default concepts using the list box. If you want to configure your
concept from scratch, select 'Blank concept'.

Based on your concept, QUE$TOR will select typical oil and gas export
options. Adjust these to match your desired product export routes.

When you click OK QUE$TOR runs the complete cost estimate using
program defaults throughout and displays the field development
schematic along with the cost summary tree.
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Selecting a Concept - Onshore

The Concept selector form allows you to choose the basic concept of
your field development.

Concept selector
MNew

Development concept

Wellpad group to main production facility e

Wellpads directly tied back to production facilities with oil/gas processing and product expart facilities to a teminal
and/or gas grid.

Product destination
il Inland terminal w LPG Mone -
Gas Gas grd w Gasoline Mone v
NGL Maone w
Imports
Water Aquifer .| Distance to main production facility e
Disposal
Water Mone -
Irfrastructure
Infrastructure
Distances

Distance from main production facility to inland terminal o
Distance from main production facility to gas export location em

& Cancel

QUES$TOR selects a field development concept based on the field level
data and production profile. You can change this to another of the 6
default concepts using the list box. If you want to configure your
concept from scratch, select 'Blank concept'.

Based on your concept, QUE$TOR will select typical oil and gas export
options. Adjust these to match your desired product export routes.
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When you click OK QUE$TOR runs the complete cost estimate using
program defaults throughout and displays the field development
schematic along with the cost summary tree.
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Using the Field Development Schematic

On selecting your concept and clicking OK QUE$TOR will move through
to the main field development schematic.

(9 QUESTOR - New offshore project — (n] x
| AT [ ¢ S
Reports Tools Help
- i,
BE aSE
it Save Save Print

Newproject Open  Recen nt  Exp
projects ¥ preview 10 Exc

Project Save Export

Cost (million $) @ Offshore fpimary)  Onshore  LNG regas onshore

Component
- s || - (8- 8- @B - (1B -[H[e][e][0] 7 4=

Equipment 43.270
Materials 15.229
Fabrication 36.128
Installation 15.378 1
Hook-up and commissi 7.354
Design &Project man 19.847
Insurance & Certificat... 7.110
Contingency 14,932
2 [l 1acket 2 109.713
Materials 25.759

g P -
Fabrication 45.185 Offshore drilling 1
|

Installation 16,170

Design &Project man 7.875
Insurance & Certificat 4750
Contingency 2.974
[ 1] offshare driling 2 w9232 |
Equipment 3712
Materials 41.408
Installation 83.000
Design &Projectman 2937
Insurance & Certificat 8.303
Contingency 34872
= [ Topsides 1 855.963
Equipment 270.960
Materials 90.274
Fabrication 182.293
Installation 21,734

[ overview Show

The field development schematic shows the components within your
chosen concept on the right hand side of the screen, with the
associated high level CAPEX summary on the left hand side of the
screen.

The schematic can be changed by adding and removing components.
You can select components to add from the component toolbar at the
top of the screen and click on the schematic to place the component. To
delete a component hit delete when the component is selected or right
click on the component and select Delete. You will be asked to confirm
any deletions to prevent any components being inadvertently deleted.

Components often require links so that the correct data can flow
between them. Components are linked using the link icon in the toolbar

4 Once you have linked two components you may need to add a
pipeline by double clicking on the link.

A
% Note: Connections from drilling components, subsea, and wellpad
groups do not require pipelines to be specified.
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Each component will be estimated using default assumptions based on
the data you have entered so far. To view a component in detail you
can double click on it or right click on it and select Edit / view cost
estimate.
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Adjusting a Component

You can view the details of each component by either double clicking on
the component icon in the field development schematic or by right
clicking on the icon and selecting Edit / view cost estimate.

@ QUESTOR - New offshore project - [m] X
DE@FO .S LFE Wl -

Z Proicct  Optons  Reports  Tools
TIETEE
z
L HE Q&
New project Open  Recent Save Saveas  Print  Print  Export
projects preview to Excel
Project Save Export. -~
Component Cost (million $)
- & T
Equipment 270.950 Topsides 1 [ Hame I Topsides 1|
Materisls 90.274
Fabrication 182.203 | | [TOTALCOST US Dollars 855,963,000
Installation 21.734
Hook-up and commissi... 73.188 Total dry weight 11.601te (16.243te Op))
Design &Projectman 102.6%4 EQUIPMENT Frocured from: Canada Fasl|
Insurance & Certficat 37.055 QUANTITY UNIT RATE cosT
Facilties Ptatform xmas trees and spools %1
Manifolding Bt T Marifolds e 51400 3,649,000
Oil processing Drilling facilities ! W0t 2750 275,000
Multiphase meters (0-6 Mbbl/da, 0 390,500 0|
@l Grmms 2= ( 1) ks
Multiphase meters (6-20 Mbbliday) 0 578,500 0
(Gas processing Process utilties Multiphase meters (20-75 Mbbl/day) 0 846,000 0
Gas compression Flare structure B 3 Ote 78.100] 0l
WWater injection Power 0l processing
Custom savipment Separation Bt 57,800 4,682,000
Dehydration 0t 7030 0|
Pimary Corfiguration Installation Expot Design Lease ‘Shell & tube heating Tte 75.300) 531,000)
Functions Shell & tube cooling 294 7590 2,201,000
Welhead @  Diling (-] Fin fan cooling 0t 41.200) 0
Production a Quarters [] Flate & frame heating Ote 206,100 0|
Comprassion ] Plate & frame cooling 0t 206,100 0
Ol export
Capacties Oil pump, driver and metering 119te 48,600 5,783,000
Ol / condensate 108 Mpbl/day Export oil pig launcher 0te 32.200) 0
Wt 125 Mbbl/day Dry il tank B 5570 184,000
Export /flared gas 0 MMsct/day (e e
— Gas
(s injection 126 MMsci/day i) _
it e Shell & tube I Dte | 75.900] 0|
= 0 MMsciday Finfan | B 41,200 1,483,000
Mercury removal
Mercury removal I Ote | 36,200] 0|
View equipment list oK Cancel

Each component has two main parts to it: the inputs, where you can
adjust the design parameters, and the cost sheet, where you can see
the detailed breakdown of the cost.

You can make changes within each of these areas and when you click
Apply or OK these changes will be applied to the component and the
CAPEX estimate adjusted accordingly. Clicking on OK will also exit the
component. Clicking Cancel also exits the component; however you
will lose all changes made since you entered the component.

Inputs

The left hand side of the screen contains the main input data for that
component. The input form for the topsides component is shown
below.
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Facilities
EJ Manifolding EJ Control and comms
&3 il processing &J Drilling facilities
&3 Oil export EJ Quarters
EJ Gas processing EJ Process utilities
EJ Gas compression EJ Flare structure
&3 Water injection & Power

a Custom eguipment

......................

Functions

Wellhead Drilling
Production Quarters
Compression

Capacities

il / condensate Mbbl day
Water injection Mbbl/day

Export / flared gas Ijl MMscf/day
Gas injection MMscf/day

Ges i [ O] MMsci/day

The input form shows the main design parameters for a given
component, such as the design flowrates. You can make changes to
these values to match your design assumptions. When you click Apply
these changes will be applied to the component and the CAPEX
estimate adjusted accordingly.

Sub-components

There are arrow buttons &l within many components that can be
clicked on to open up one of the sub-components; the details of that
system are then shown. The topsides Manifolding sub-component form
is shown below.
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Manifolding
Manifolds  Accessories

Manifalds

Service Number  Flowrate Selected Operating Design \neight

of inlets pressure pressure

Gas lift [ o|mmsciay O

Number of well bays / porches Manifolds tatal =
& Cance

You can make changes within each sub-component and when you click
OK these changes will be applied to the component and the CAPEX
estimate adjusted accordingly.

Cost sheet

The right hand side of the screen has the cost sheet. This shows a
detailed breakdown of the CAPEX estimate for the component. Each
line item is made up of a quantity and a unit rate.

QUAMTITY LIMIT RATE CasT
= 150 te 29,500 4,425,000

The quantity is calculated from the design parameters and technical
algorithms for that item and the unit rate is taken from the selected
procurement strategy. You can overwrite any of the blue values within
the cost sheet, as shown for the quantity entry above. Numbers in
black are derived by multiplying the quantity by the unit rate so can't
be overwritten.
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Calculating the Operating Costs

The operating cost calculations should be run once you have finished
the design of your development as the costs are based on the technical
definition of the development.

The OPEX algorithms are run by selecting OPEX from the Project
menu. This will open a separate window where a summary of the
operating costs for each year of production is displayed.

Operating expenditure analysis

&k H &

Offshore operating cost summary

Totals Year 1 Year 2 Year 3 Year 4 Year &
Grand total operating cost ] 960.301 ﬂﬂﬂ| 74.888.(:m| ams-mmu| m}.m.um| El 4-130(_)(‘.‘| El .2-16.!)(_)(}'
Direct costs
Operating personnel cosk ] 168,784,000 15,344,000 15,344,000 15,344,000 15,344,000 15,344,000
Inspection & maintenance cosE g 224 395,000 17,835,000 17,835,000 17,835,000 17,835,000 18,701,000
Logistics & consumables csis $ 138,023,000 15,176,000 17,931,000 17,931,000 17,931,000 17,931,000
nfell costs k3 24,524,000 2,176,000 3,545,000 3,945,000 12,670,000 11,701,000
Insurance costs ] 80,212,000 7,252,000 7,252,000 7,252,000 7,252,000 7,252,000
Direct costs total $ 745,938,000 57,883,000 62,411,000 62,411,000 71,132,000 70,969,000
Eield/project cosis $ 214,363,000 17,005,000 18,137.000 18,137.000 20,317,000 20,277,000
Tarnffcosk 5 /] 1] 1] 0 0 0
CO2 emission faxes 5 0 1] 1] 1] (i} (i}
Leasecose g 1] 0 0 0 0 0
< >
@ Cancel

The costs are broken down into various categories, which can be seen
on the left side of the screen. The detailed breakdown of these cost
categories can be seen by clicking on these items, they are formatted
as blue hypertext. This will open up further definition sheets for you to
review or adjust the default values.

Once you are happy with the operating costs, click OK to go back to
field development schematic so that you can generate the project
schedule.
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Scheduling the Capital Costs

The CAPEX scheduling calculations should be run once you have
finished the design of your development as the schedule and costs are
based on the details of the development.

The CAPEX scheduling module can be accessed by selecting
Scheduling from the Project menu. The schedule will be shown as a
Gantt chart along with the underlying data for each component.

CAPEX scheduling
& & @ # B B i [T E Calendar |1 2021| Zoom |100% ~
. Start Durabion Cost =
Activity (mth) (mths) (million %) L=t ] 12 18 24 30 36 42 43 B4 60 66 72 78 ad
+ Topsides 1 A
Total CAPEX 2 e 523.405
£ Oil pipeline (ofishore 1)
Total CAPEX 24 2 £4.341
+ Semi-sub 1
Total CAPEX 20 26 211.996
+ Subsea 1
Total CAPEX 9 3 827822
+ Offshore drilling 1
Total CAPEX 1 75 £28.096
W
[ =
& Carcel

For each component, a detailed schedule can be viewed by expanding

the component using the * icon. You can adjust the start date and
activity duration either by dragging the bars within the Gantt chart or
by adjusting the corresponding values in the table. Adjusting these
values will change when the calculated CAPEX values are to be spent.

Once you are happy with the project schedule, click OK to go back to
field development schematic so that you can generate the Investment
and production profile.
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Generating the Investment and Production
Profile

The investment and production profile is run by selecting Investment
and production profiles from the Project menu.

The investment and production profile gives a report of all of the values
that could be required to run an economic analysis, with the
production, CAPEX and OPEX given for each year of the project. The
values in this report are in real terms, i.e. they are costs specific to a
particular point in time (depending on the version) and have not been
inflated or discounted over the life of the project.

This report can be printed or exported to Excel using the toolbar
buttons.
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Saving Your Project

Projects are not automatically saved in QUE$TOR. We recommend you
save your project when you reach the field development schematic and
at regular intervals after this.

To save a project select Save or Save As from the File menu or click

on the Save project buttonH . This will enable you to save the project
in the usual Windows fashion. The default location for saved projects is
Documents\SPGlobal\QUE$TOR\Projects.

Saved project files have a “.qpr” file extension and include the selected
procurement strategy, technical database and unit set. Once saved,
projects are completely standalone and have no further interaction
with QUE$TOR’s databases. This means that saved projects can easily
be sent to others who may not have the same databases.

Saved projects can be moved, copied and renamed using Microsoft
Windows Explorer in the same way as any Windows file. Projects can be
opened either directly from Windows Explorer or from within QUE$TOR.
To open a saved project in QUE$TOR either select Open existing
project from the form that appears when QUE$TOR starts or select
Open from the File menu.

y
% Note: When you create a new project you won't be able to save
the project until you reach the field development schematic.

Opening a Saved Project

To open a saved project select, using the option buttons, Browse for

project and click OK to proceed or click on the Open project button

. This will enable you to open a project in the usual windows
fashion. The Open existing project box has shortcuts to the last five
projects opened in QUE$TOR. Saved projects have a “.gpr” file
extension.
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Contacting customer support

Requests for support related to the QUE$TOR application should be
directed to ci.support@spglobal.com.

Requests can also be submitted through our website.

Or by phone

Americas: +1 800447 2273

Europe, Middle East and Africa: +44 (0) 1344 328 300
Asia Pacific: +604 291 3600
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Copyright
Copyright© 2026, S&P Global. All rights reserved.
Windows® is a registered trademark of Microsoft Corporation.

All other trademarks and service marks, including without limitation
QUE$TOR® belong to S&P Global and its affiliated and subsidiary
companies, all rights reserved.

This product, including software, data and documentation1, is licensed
to the authorized user for its internal business purposes only and no
part thereof may be disclosed, disseminated, sold, licensed, copied,
reproduced, translated, transmitted or transferred to any third party.
All rights reserved.

S&P Global Headquarters.
55 Water Street

New York NY

10041

1Build: 2026-05-20:09:17:54
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